
Actel® FlashPro v3.1
User’s Guide 
Windows®



Actel Corporation, Sunnyvale, CA 94086
© 2003 Actel Corporation. All rights reserved.

Printed in the United States of America

Part Number: 5029138-6

Release: June 2003

No part of this document may be copied or reproduced in any form or by any means 
without prior written consent of Actel.

Actel makes no warranties with respect to this documentation and disclaims any im-
plied warranties of merchantability or fitness for a particular purpose. Information 
in this document is subject to change without notice. Actel assumes no responsibil-
ity for any errors that may appear in this document. 
This document contains confidential proprietary information that is not to be dis-
closed to any unauthorized person without prior written consent of Actel Corpora-
tion. 
Trademarks 
Actel and the Actel logotype are registered trademarks of Actel Corporation.

Adobe and Acrobat Reader are registered trademarks of Adobe Systems, Inc.

Liberty is a licensed trademark of Synopsys Inc. This product uses SDC, a Propri-
etary format of Synopsys Inc.

Libero is a trademark of Actel Corporation.

Mentor Graphics, Viewlogic, ViewDraw, MOTIVE, and ModelSim are registered 
trademarks of Mentor Graphics, Inc.

Synplify and Synplicity are registered trademarks of Synplicity, Inc.

Verilog is a registered trademark of Open Verilog International.

WaveFormer Lite and SynaptiCAD are trademarks of SynaptiCAD, Inc.

Windows is a registered trademark and Windows NT is a trademark of Microsoft 
Corporation in the U.S. and other countries.

All other products or brand names mentioned are trademarks or registered trade-
marks of their respective holders.
ii



 Table of Contents
Table of Contents

1 Introduction   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 9
Document Organization  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 9
Document Assumptions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10
Document Conventions   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10
Platform Support  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 10
Actel Application Notes   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11
Actel User Manuals .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11

2 Getting Started  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 15
FlashPro Kit.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 15
Software Installation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 15
Software Update   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 19
Hardware Installation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 20

Powering Down the Programmer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
Hardware Update .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
Self-Test .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 22
Starting FlashPro  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24
FlashPro Software Graphical User Interface .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 25

Menu Bar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  25

Toolbar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  26

Action  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27

Device .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27

Log Window.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27

3 Using FlashPro  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29
Initial Setup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29
Analyze Chain and Device Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 32
Loading the STAPL File  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 33
Selecting an Action  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35
iii



Table of Contents
Programming a Device.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .35
Verifying the Correct Programming .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .37
Permanently Lock the Device .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .39

Loading the Permanent Lock STAPL File: .  .  .  .  .  .  .  .  .  .  .  .  .  .39
Programming a Device Using Permanent Lock  .  .  .  .  .  .  .  .  .  .  .40

Saving Your Log File   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .42

4 Using FlashPro Lite .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  45
Hardware Installation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .45
Initial Setup   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .45
Analyze Chain and Device Selection   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .48
Loading the STAPL File .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .49
Selecting an Action.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .50
Programming a Device.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .51
Verifying the Correct Programming .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .53
Permanently Lock the Device .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .55

Loading the Permanent Lock STAPL File: .  .  .  .  .  .  .  .  .  .  .  .  .  .55
Programming a Device Using Permanent Lock  .  .  .  .  .  .  .  .  .  .  .56

Saving Your Log File   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .58

A Error Messages & Trouble Shooting Tips  .  .  .  .  .  .  .  .  . 61
Exit 0 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .62
Exit 3 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .62
Exit 5 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .62
Exit 6 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .62
Exit 7 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .63
Exit 8 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .63
Exit 11  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .63
Exit 12  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .64
Exit 15  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .64
Exit 17  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .64
Exit 80  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .64
Exit 90  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .65
iv



 Table of Contents
Exit 91.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 65
Cable to target is not connected properly   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 65
Chain Integrity Test Failed: XX   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 66
Could not connect to programmer on port lpt1 or Parallel port device does 
not support IEEE-1284 negotiation protocol  .  .  .  .  .  .  .  .  .  .  .  .  .  . 67
External Voltage Detected on <Supply>   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 67
Failed self-test. VDDP setting: Expected 2300...27000. Actual 750 .  .  . 68
Loopback Failure TDI -> TDO. Expected 1, Actual 0  .  .  .  .  .  .  .  .  . 68
More than one unidentified device cannot continue .  .  .  .  .  .  .  .  .  .  . 68
Self-test  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 69
VDDP Disconnected .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 69

B Software Freeze .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 71

C Product Support   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 73
Actel U.S. Toll-Free Line .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 73
Customer Service .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 73
Customer Applications Center  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 74
Guru Automated Technical Support .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 74
Web Site.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 74
FTP Site .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 74
Contacting the Customer Applications Center .  .  .  .  .  .  .  .  .  .  .  .  .  . 75

Electronic Mail .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 75
Telephone  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 75

Worldwide Sales Offices  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 76
Headquarters .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 76

US Sales  
Offices .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76

International Sales Offices   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
v



Table of Contents
vi



List of Figures
List of Figures

FlashPro Installation Wizard  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 16
License Agreement   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 17
FlashPro Destination Location  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 18
FlashPro Release Notes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 19
Software Update Help Drop Down Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 20
Version Mismatch Dialog Box   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 21
Hardware Update Dialog Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 22
Starting FlashPro Diagnostic  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 23
Starting FlashPro   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24
FlashPro Software Graphical User Interface  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 25
FlashPro Toolbar  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 26
FlashPro: Connect to Programmer Dialog Box   .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29
Connect to Programmer Dialog Box for ProASIC Devices  .  .  .  .  .  .  .  .  . 30
FlashPro: Successful Connection  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 31
FlashPro: Analyzing Chain   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 32
FlashPro: Device Selection  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 33
Open File Toolbar Button   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
Open Dialog Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 34
Execute Toolbar Button   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 36
Execute Action Dialog Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 36
Successfully Programmed Device .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 37
Execute Toolbar Button   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 37
Execute Action Dialog Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 38
Successful Verification   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 39
Permanent Lock About Dialog Box   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
Execute Toolbar Button   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 40
Execute Action Dialog Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 41
Query Results for the Permanently Locked Device   .  .  .  .  .  .  .  .  .  .  .  .  . 42
Save Dialog Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 43
vii



List of Figures
FlashPro: Connect to Programmer Dialog Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .46
Connect to Programmer Dialog Box for ProASIC Devices .  .  .  .  .  .  .  .  .  .46
FlashPro: Successful Connection   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .47
FlashPro: Analyzing Chain .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .48
Open File Toolbar Button  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .49
Open Dialog Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .49
STAPL File Loaded Successfully .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .50
Execute Toolbar Button  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .51
Execute Action Dialog Box   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .52
Successfully Programmed Device  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .53
Execute Toolbar Button  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .53
Execute Action Dialog Box   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .54
Successful Verification  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .55
Permanent Lock About Dialog Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .56
Execute Toolbar Button  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .56
Execute Action Dialog Box   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .57
Query Results for the Permanently Locked Device  .  .  .  .  .  .  .  .  .  .  .  .  .  .58
Save Dialog Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .59
viii



Introduction

Thank you for selecting the FlashPro Programming System. This User’s Guide is 
designed to help you take full advantage of FlashPro’s capabilities.

Document Organization
This guide provides detailed information about FlashPro. Step-by-step 
instructions for using FlashPro on Windows are included in this guide. This 
guide is based on FlashPro version 3.1.

The FlashPro User’s Guide is divided into the following chapters:

Chapter 1 - "Getting Started" explains how to install the hardware and 
software for FlashPro and FlashPro Lite. Details about the graphical user 
interface are also included.

Chapter 2 - "Using FlashPro" describes how to use the FlashPro software to 
program ProASIC and ProASIC PLUS devices.

Chapter 3- "Using FlashPro Lite" describes how to use FlashPro Lite to 
program ProASICPLUS devices.

Appendix A - "Error Messages & Trouble Shooting Tips" contains 
workarounds for error messages and warnings.

Appendix B - "Software Freeze"describes the steps to take if the FlashPro 
software crashes.

Appendix C - "Product Support" describes our support services.
9



Document Assumptions
The information in this manual is based on the following assumptions:

1. You are familiar with the Actel Designer software.

2. You are familiar with FPGA architecture and FPGA design software.

Platform Support
Supported platforms for the PC include:

• Win98

• Win2000

• WinXP

• WinNT 4.0 SP6

Actel Application Notes
Application Notes are available at our web site, http://www.actel.com/
products/tools/prog.asp.

Several Application Notes are specifically helpful to programming 
ProASIC and ProASICPLUS devices.

• Programming Actel Devices

• Implementation of Security in Actel’s ProASIC and ProASICPLUS Flash Based 
FPGAs.

• In-System Programming ProASICPLUS Devices.

Actel User Manuals
Other Actel user manuals are available at our web site, under Technical 
Documentation, http://www.actel.com/techdocs/manuals/index.html.
10
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These manuals provide additional information on designing Actel FPGAs. 
They include:

Getting Started User’s Guide. This manual contains information for using the 
Designer Series Development System software to create designs for, and 
program, Actel devices. 

Libero IDE User’s Guide. This manual contains information about using Libero 
IDE, Actel’s Integrated Design Environment. Details about using ViewDraw 
for Actel, WaveFormer Lite, Synplicity, and ModelSim are provided.

Designer User’s Guide. This manual provides an introduction to the Designer 
series software as well as an explanation of its tools and features.

PinEdit User’s Guide. This guide provides a detailed description of the PinEdit 
tool in Designer. It includes cross-platform explanations of all the PinEdit 
features.

ChipEdit User’s Guide. This guide provides a detailed description of the ChipEdit 
tool in Designer. It includes a detailed explanation of the ChipEdit 
functionality.

Timer User’s Guide. This guide provides a detailed description of the Timer tool 
in Designer. It includes a detailed explanation of the Timer functionality.

Netlist Viewr User’s Guide. This guide provides a detailed description of how to 
use the Actel Netlist Viewer tool to view your netlist and how to use it with 
other Actel tools to analyze your netlist.

SmartPower User’s Guide. This guide contains information on how to use the the 
Actel SmartPower tool to perform power analysis.

Actel HDL Coding Style Guide. This guide provides preferred coding styles for 
the Actel architecture and information about optimizing your HDL code for 
Actel devices.

FlashPro User’s Guide. This guide contains information to assist designer in the 
use of Actel’s FlashPro programmer.

Mentor Graphics® Interface Guide. This guide contains information to 
assist designers in the design of Actel devices using Mentor Graphics 
CAE software and the Designer Series software.

Synopsys®Synthesis Methodology Guide. This guide contains preferred 
HDL coding styles and information to assist designers in the design of 
11



Actel devices using Synopsys CAE software and the Designer Series 
software.

Innoveda® eProduct Designer Interface Guide (Windows). This guide 
contains information to assist designers in the design of Actel devices 
using eProduct Designer CAE software and the Designer Series 
software.

Innoveda® eProduct Designer Interface Guide (UNIX). This guide 
contains information to assist designers in the design of Actel devices 
using eProduct Designer CAE software and the Designer Series 
software.

VHDL Vital Simulation Guide. This guide contains information to assist 
designers in simulating Actel designs using a Vital compliant VHDL 
simulator.

Verilog Simulation Guide. This guide contains information to assist 
designers in simulating Actel designs using a Verilog simulator.

Silicon Sculptor User’s Guide. This guide contains information about 
how to program Actel devices using the Silicon Sculptor software and 
device programmer.

Silicon Explorer Quick Start. This guide contains information about 
connecting the Silicon Explorer diagnostic tool and using it to perform 
system verification.

Actel FPGA Data Book. This guide contains detailed specifications on 
Actel device families. Information such as propagation delays, device 
package pinout, derating factors, and power calculations are found in 
this guide.

Macro Library Guide. This guide provides descriptions of Actel library 
elements for Actel device families. Symbols, truth tables, and module 
count are included for all macros. 

A Guide to ACTgen Macros. This Guide provides descriptions of 
macros that can be generated using the Actel ACTgen Macro Builder 
software.
12



1
Getting Started

This chapter describes what should be included in the FlashPro and FlashPro 
Lite kits and how to install the FlashPro software and hardware. It also contains 
an overview of the graphical user interface and commands.

For specific details about the board layout, please refer to the Actel Application 
Note, In-System Programming ProASICPLUS Devices.

FlashPro Kit
The FlashPro kit contains:

• FlashPro CD

• FlashPro Actel Programmer

• IEEE-1284 25 pin cable, Type A-C, 10 ft.

• Loop Back Test board

• Power supply brick and cable

FlashPro Lite Kit
The FlashPro Lite kit contains:

• FlashPro Lite CD

• FlashPro Lite Programmer

• IEEE-1284 25 pin extension cable, Type A-A, 10 ft.

• 18 inch programmer target cable, 26 pin

Software Installation
After installing the FlashPro software, you must install the most recent service 
packs available from our website at

http://www.actel.com/custsup/updates/flashpro/index.html.
13
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Chapter 1: Getting Started
To install the FlashPro software:

1. Insert the FlashPro CD into your drive. The installation wizard 
starts, as shown in Figure 1-1.

Figure 1-1. FlashPro Installation Wizard

2. Click Next to see the license agreement.
14



Software Installation
3. Click Yes, then Next to accept the license agreement, as 
shown in Figure 1-2.

Figure 1-2. License Agreement

4. Click Next to install FlashPro to the destination folder, as 
shown in Figure 1-3. To install to a different folder, click Browse and 
15



Chapter 1: Getting Started
select another folder. FlashPro installs the software to the directory you 
select.

Figure 1-3. FlashPro Destination Location

5. Click Next to install. The FlashPro software installs. 

6. Click Finish to restart your computer as shown in Figure 1-4. 
Actel recommends that you restart your computer before starting FlashPro.
16



Software Update
Figure 1-4. Installation Complete

Software Update
For the latest software update available, visit the Actel website at  
http:// www.actel.com/custsup/updates/flashpro/index.html or by selecting 
Software Update from the Help drop down menu in the FlashPro software. See 
Figure 1-5.

Note: Select Software Update from the Help menu to visit the Actel website. 
17
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Chapter 1: Getting Started
Figure 1-5. Software Update Help Drop Down Menu

Hardware Installation
For FlashPro Lite hardware installation procedures, please refer to “Hardware 
Installation”.

To connect the FlashPro to your PC:

1. Connect the programmer to a parallel printer port on your 
PC. Connect one end of the IEEE-1284 cable to the programmer’s 
connector. Plug the other end of the cable into your parallel printer port and 
tighten the screws. You should not have any licensing dongles connected 
between the parallel port and cable.

Your port settings should be EPP or bidirectional. Actel also supports the 
ECP mode with the FlashPro version 2.1 software and newer versions.

2. Verify that you are connected to the correct parallel port on 
your computer. Actel recommends that you dedicate a port to the 
programmer. Connecting to a serial port or a third party card may damage 
the programmer. This type of damage is not covered by the warranty.

3. Verify that the FlashPro power switch is in the 0 position.
18



Hardware Update
4. Power up the programmer. Plug the DC adapter into a power socket. 
Plug the other end of the AC power supply to the DC-IN input at the back 
of the FlashPro.

5. Turn on the programmer. Turn the FlashPro power switch to the 1 
position. The POWER LED on the front of the programmer lights up. If 
it does not, contact Actel technical support at (888) 99-ACTEL.

Powering Down 
the 
Programmer

Before you power down the programmer, make sure of the following:

• The programmer is not active

• The programming sequence is complete

• You are not programming a device

• Turn the FlashPro power switch to the 0 position

• Disconnect the programmer from the parallel port

Hardware Update
After you install or update the FlashPro software, a Version Mismatch dialog 
box may appear, as shown in Figure 1-6, so you can download an update to 
your FlashPro hardware. 

To update your hardware: 

1. Click OK as shown in Figure 1-6.

Figure 1-6. Version Mismatch Dialog Box
19



Chapter 1: Getting Started
2. After reading the message in the Hardware Update dialog 
box, click OK as shown in Figure 1-7.

Figure 1-7. Hardware Update Dialog Box

The Updating Hardware status window displays while your hardware 
updates.

Self-Test
Before you program any devices, please run the self-diagnostic test. 

To run the self-diagnositc test: 

1. Connect the loopback test board to the FlashPro 
programmer. (The loopback test board is included in the FlashPro kit.)

2. Connect the FlashPro programmer to your PC’s parallel port.

3. Turn on the FlashPro programmer.

4. Start the FlashPro Diagnostic software. From the Start menu, point 
to Programs, FlashPro V3.1, and click Diagnostic.

5. Connect to the FlashPro programmer by entering

openport lpt<port number>

The port number represents the parallel port you used to connect to the 
FlashPro programmer. If the FlashPro is connected to port 1, you would 
enter:

openport lpt1
20



Starting FlashPro
If this fails, check your licensing dongles and make sure the FlashPro’s 
power is turned on.

6. Enter 

test

The unit enters the self-test mode, which lasts less than one minute. Do not 
interrupt the unit until the self-test mode is completed. If the self-test fails, you 
may see the following error messages:

• Failed self-test. VDDP setting: Expected 2300...27000. Actual 750 (see page 
57).

• Loopback failure TDI->TDO. Expected 1, Actual 0 (see page 57).

• Parallel port device does not support IEEE-1284 negotiation protocol (see 
page 57).

Please refer to “Error Messages & Trouble Shooting Tips” for help with error 
messages. If you are not successful, please contact technical support at 
tech@actel.com for assistance.

Starting FlashPro
From the Start menu, select Programs, FlashPro V3.1, and click FlashPro V3.1, to 
start FlashPro. 

Note: If you installed the program in another folder other than FlashPro, 
choose that folder from the Programs menu.
21
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Chapter 1: Getting Started
FlashPro Software Graphical User Interface
The FlashPro software, as shown in Figure 1-8, consists of a menu bar, toolbar, 
log window, and areas to specify your STAPL file, device, and action.

Figure 1-8. FlashPro Software Graphical User Interface

Menu Bar

Use the menu bar to set up your programmer connection, specify the device, 
and to save your log file. From the File menu, you can set up the programmer 
connection, specify the device, and save or clear the programming log file, 
which appears in the log window.

STAPL File Location

Log
Window

Desired 
Device

Menu Bar

Tool Bar

Desired
Action
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FlashPro Software Graphical User Interface
Toolbar

The toolbar buttons in the toolbar, as shown in Figure 1-9, allow you to open a 
programming file (*.stp) and execute the action you selected from the Action 
window. 

Figure 1-9. FlashPro Toolbar

 Save Log

  

 

ExecuteOpen
File
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Action

Use the Action list menu to specify the action you want performed on the 
device. Options are available when a STAPL file is loaded. Options appear in 
Table 1-1.

Device

Options in the Device list specify the device within a chain. The selected action 
in the Action list is applied to this device. The Device list only appears after 
selecting Analyze Chain from the File menu.

Log Window

The Log window displays results of the action and any error messages.

Table 1-1. Action Options

Option Action

QUERY_SECURITY

Checks the security status of the device. If the 
device is programmed with the security key, then 
this command returns with Read inhibit:1 Write 
inhibit:1. If the security key is not present, the val-
ues are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE Reads the device ID code.

VERIFY

Verifies whether the device was programmed with 
the loaded STAPL file. If the wrong STAPL file is 
loaded, Exit 11 appears in the log window. A suc-
cessful operation results in Exit 0.

PROGRAM Programs the device.

DEVICE_INFO
Displays the serial number of the device, the Design 
Name that is programmed into the device, and the 
checksum that is programmed into the device.
24



2
Using FlashPro

This chapter describes how to use the FlashPro programmer to program Actel 
ProASIC and ProASICPLUS devices. All screen shots shown refer to 
ProASICPLUS devices only and the options may vary for ProASIC devices.

Initial Setup
Before any action can be performed with the FlashPro programmer, it must be 
properly setup. Please properly connect the FlashPro ribbon cable with the 
programming header and turn on the switch.

Actel recommends running the self test before programming any devices, see 
“Self-Test” on page 20.

To setup FlashPro:

1. From the File menu, click Connect. The FlashPro Connect to 
Programmer dialog box displays, as shown in Figure 2-1. 

Figure 2-1. FlashPro: Connect to Programmer Dialog Box

2. In the Port list, select the port the FlashPro programmer is 
connected to.

3. In the Configuration list, select the device family (ProASIC or 
ProASIC PLUS).

4. (Optional) Disable voltages from the programmer if they are 
available on the board. When you select the ProASIC configuration, 
25



Chapter : Using FlashPro
the Drive TRST voltage turns grey and becomes unavailable. See 
Figure 2-2.

Figure 2-2. Connect to Programmer Dialog Box for ProASIC Devices

Note: If you want to power-up the device from the board power supply, 
please deselect Vddl and Vddp. Vpp and Vpn are required during 
programming only and are supplied by the FlashPro programmer. 
Programming of ProASIC devices requires that Vddl be at 0 volts 
during programming. The board power supply design must allow for 
this if it is used to power-up the device during programming. 
ProASICPLUS devices do not have this requirement.
26



Analyze Chain and Device Selection
5. Click Connect. A successful connect or any errors appears in the Log 
window, as shown in Figure 2-3. If you encounter failures, please refer to 
“Error Messages & Trouble Shooting Tips” for more information. 

Figure 2-3. FlashPro: Successful Connection

Analyze Chain and Device Selection

To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in 
the Log window, as shown in Figure 2-4. If you encounter any failures, 
27



Chapter : Using FlashPro
please refer to “Error Messages & Trouble Shooting Tips” for more 
information.

Figure 2-4. FlashPro: Analyzing Chain

2. Select your devices. In the Device list, select your device before you 
perform any action. If you have only one device in the chain, performing 
Analyze Chain selects that device automatically from the Device list. If you 
28



Loading the STAPL File
have multiple devices in the chain, you must select a device as shown in 
Figure 2-5. 

Figure 2-5. FlashPro: Device Selection

Note: The first device, selected in Figure 2-5, is the device that is nearest 
to TDO of the programming header.

Loading the STAPL File
The FlashPro programmer uses a STAPL (*.stp) file to program the device. 
Export the STAPL file from Designer. For more information, please refer to 
the Designer Online Help. 

Note: The STAPL file must be generated from Designer R1-2003SP1 or later. 
Actel strongly recommends using the latest version of Designer software 
or Libero IDE with the most recent service pack installed. Software 
service packs can be found at 
http://www.actel.com/custsup/updates/index.html.
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Chapter : Using FlashPro
To load the STAPL file:

1. Click the Open File button in the toolbar, as shown in 
Figure 2-6. 

Figure 2-6. Open File Toolbar Button

The Open dialog box appears, as shown in Figure 2-7.

Figure 2-7. Open Dialog Box

2. Select your STAPL file and click Open. The FlashPro software loads 
the file.
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Selecting an Action
Selecting an Action
After loading the STAPL file, select an action from the Action list. See 
Table 2-1 for a definiton of each action.

Programming a Device

To program a device:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

Table 2-1. Action Options

Option Action

QUERY_SECURITY

Checks the security status of the device. If the 
device is programmed with the security key, then 
this command returns with Read inhibit:1 Write 
inhibit:1. If the security key is not present, the val-
ues are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE Reads the device ID code.

VERIFY

Verifies whether the device was programmed with 
the loaded STPL file. If the wrong STPL file is 
loaded, Exit 11 appears in the log window. A suc-
cessful operation results in Exit 0.

PROGRAM Programs the device.

DEVICE_INFO
Displays the serial number of the device, the Design 
Name that is programmed into the device, and the 
checksum that is programmed into the device.
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Chapter : Using FlashPro
3. Click the Execute button in the toolbar, as shown in 
Figure 2-8. 

Figure 2-8. Execute Toolbar Button

The Execute Action dialog box appears, as shown in Figure 2-9.

Figure 2-9. Execute Action Dialog Box

All the steps of the programming sequence are listed. Optional steps appear 
in bold. Grayed out options are required for programming and cannot be 
changed.

4. Make your selections and click Execute to start 
programming. The progress of the programming action displays in the 
Log window. 

The message 'Exit 0' indicates that the device has been successfully programed, 
as shown in Figure 2-10.

Note: Do not interrupt the programming sequence, it may damage the 
device or programmer.
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Verifying the Correct Programming
Figure 2-10. Successfully Programmed Device

If you encounter any failures, please refer to “Error Messages & Trouble 
Shooting Tips” for more information.

Verifying the Correct Programming

To verify the device is programmed with the correct STAPL file:

1. Load the STAPL file.

2. In the Action list, click VERIFY.

3. Click the Execute button in the toolbar, as shown in  
Figure 2-11. 

Figure 2-11. Execute Toolbar Button
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Chapter : Using FlashPro
The Execute Action dialog box appears, as shown in Figure 2-12.

Figure 2-12. Execute Action Dialog Box

The default settings appear in the Execute Action dialog box.

4. Click Execute to start the verification process. A successful 
verification will result in Exit 0, as shown in Figure 2-13. If the STPL file is 
different from the file used for programming, Exit 11 appears in the Log 
window (see “Error Messages & Trouble Shooting Tips”, “Exit 11” for 
more details).
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Permanently Lock the Device
Note: Do not interrupt the verifying sequence, it may damage the device.

Figure 2-13. Successful Verification

Permanently Lock the Device
The FlashPro software includes a new feature which enables you to 
permanently lock your device. The permanent lock feature permanently locks 
your device and prevents you from reprogramming. This provides the highest 
level of security to the ProASICPLUS device family. 

Loading the 
Permanent 
Lock STAPL File:

Export the permanent lock STAPL file from Designer. See the note from 
“Loading the STAPL File” in this chapter.

To load the permanent lock STAPL file:

1. Click the Open File button in the toolbar. The Open dialog box 
appears.

2. Select your permanent STAPL file and click Open. The 
Permanent Lock About dialog box displays, as shown in Figure 2-14. 
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Figure 2-14. Permanent Lock About Dialog Box

3. Read the message and click OK to load the permanent STAPL 
file. The FlashPro software loads the file.

Programming a 
Device Using 
Permanent 
Lock

To program a device using Permanent Lock:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar, as shown in  
Figure 2-15.

Figure 2-15. Execute Toolbar Button

The Execute Action dialog box appears, as shown in Figure 2-16.
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Permanently Lock the Device
Figure 2-16. Execute Action Dialog Box

Note: The Do_Secure_Permanent checkbox is checked automatically. You 
have the option of unchecking this box. However, if you do, you will 
not permanently lock your device. 

All the steps in the programming sequence are listed. Optional steps appear 
in bold. Grayed out options are required for programming and cannot be 
changed. 

4. Make your selections and click Execute to start 
programming. The progress of the programming action is displayed in 
the Log window. The message 'Exit 0' indicates that the device has 
successfully been programmed as shown in Figure 2-17.
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Figure 2-17. Query Results for the Permanently Locked Device

Note: Do not interrupt the programming sequence, it may damage the 
device or programmer.

If you encounter any failures, please refer to “Error Messages & Trouble 
Shooting Tips” for more information.

Saving Your Log File
All FlashPro results are displayed in the Log window. You can save these 
results into a file.
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Saving Your Log File
To save your log file:

1. From the File menu, click Save Log. The Save dialog box appears, 
as shown in Figure 2-18.

Figure 2-18. Save Dialog Box

2. Select a directory, type in the file name, and click Save. The 
FlashPro software saves the file.
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3
Using FlashPro Lite

This chapter describes how to set up and use the FlashPro Lite to program 
Actel ProASICPLUS devices. FlashPro Lite does not support ProASIC (A500K) 
devices. All screen shots shown refer to ProASICPLUS devices only.

Hardware Installation

To connect the FlashPro Lite to your PC:

1. Connect the programmer to a parallel printer port on your 
PC. Connect one end of the IEEE-1284 cable to the programmer’s 
connector. Plug the other end of the cable into your parallel printer port and 
tighten the screws. You should not have any licensing dongles connected 
between the parallel port and cable.

Your port settings should be EPP or bidirectional. Actel also supports the 
ECP mode with the FlashPro v2.1 software and newer.

2. Verify that you are connected to the correct parallel port on 
your computer. Actel recommends that you dedicate a port to the 
programmer. Connecting to a serial port or a third party card may damage 
the programmer. This type of damage is not covered by the warranty.

3. Connect the FlashPro ribbon cable with the programming 
header and turn the target board on.

Initial Setup
Before any action can be performed with the FlashPro Lite programmer, it 
must be properly setup. See “Hardware Installation”.

The FlashPro Lite’s Live and Status LEDs should be on. This indicates that the 
FlashPro Lite is getting power from the target board and is ready to use.
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Chapter : Using FlashPro Lite
To setup FlashPro Lite:

1. From the File menu, click Connect. The FlashPro Connect to 
Programmer dialog box displays, as shown in Figure 3-1. 

Figure 3-1. FlashPro: Connect to Programmer Dialog Box

2. In the Port list, select the Line Printer (lpt) port the FlashPro 
programmer is connected to.

3. In the Configuration list, select the ProASIC PLUS device. 
FlashPro Lite only supports ProASICPLUS devices. Use FlashPro to 
program ProASIC devices.
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Analyze Chain and Device Selection
4. Click Connect. A successful connect or any errors appears in the Log 
window, as shown in Figure 3-2. If you encounter failures, please refer to 
“Error Messages & Trouble Shooting Tips” for more information. 

Figure 3-2. FlashPro: Successful Connection

Analyze Chain and Device Selection

To analyze the chain and select the device:

1. From the File menu, click Analyze Chain. Chain details appear in 
the Log window, as shown in Figure 3-3. If you encounter any failures, 
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please refer to “Error Messages & Trouble Shooting Tips” for more 
information.

Figure 3-3. FlashPro: Analyzing Chain

2. Select your devices. In the Device list, select your device before you 
perform any action. If you have only one device in the chain, performing 
Analyze Chain selects that device automatically from the Device list. 
However, if you have multiple devices in the chain, click the down arrow 
next to the Device text box, and select your device from the Device list 
menu.

Note: The first device, shown in the Device text box is the device nearest 
to TDO of the programming header.

Loading the STAPL File
The FlashPro Lite programmer uses a STAPL (*.stp) file to program the device. 
Export the STAPL file from Designer. For more information, please refer to 
the Designer Online Help. 

Note: The STAPL file must be generated from Designer R1-03SP1 or later. 
Actel strongly recommends using the latest version of Designer software 
or Libero IDE with the most recent service pack installed. Software 
44
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Loading the STAPL File
service packs can be found at http://www.actel.com/custsup/updates/
index.html.

To load the STAPL file:

1. You can click the Open File button in the toolbar, as shown in 
Figure 3-4 or from the File menu, you can click Open.

Figure 3-4. Open File Toolbar Button

The Open dialog box appears, as shown in Figure 3-5.

Figure 3-5. Open Dialog Box

2. Select your STAPL file and click Open. The FlashPro software loads 
the file. The FlashPro Log window displays a message indicating that the 
software has successfully loaded the software. See Figure 3-6.
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Chapter : Using FlashPro Lite
Figure 3-6. STAPL File Loaded Successfully

Selecting an Action
After loading the STAPL file, select an action from the Action list. See 
Table 3-1 for a definiton of each action.

Table 3-1. Action Options

Option Action

QUERY_SECURITY

Checks the security status of the device. If the 
device is programmed with the security key, then 
this command returns with Read inhibit:1 Write 
inhibit:1. If the security key is not present, the val-
ues are Read inhibit:0 Write inhibit 0.

ERASE Erases the device.

READ_IDCODE Reads the device ID code.
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Programming a Device

To program a device:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar, as shown in 
Figure 3-7. 

Figure 3-7. Execute Toolbar Button

VERIFY

Verifies whether the device was programmed with 
the loaded STPL file. If the wrong STPL file is 
loaded, Exit 11 appears in the log window. A suc-
cessful operation results in Exit 0.

PROGRAM Programs the device.

DEVICE_INFO
Displays the serial number of the device, the Design 
Name that is programmed into the device, and the 
checksum that is programmed into the device.

Table 3-1. Action Options

Option Action
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Chapter : Using FlashPro Lite
The Execute Action dialog box appears, as shown in Figure 3-8.

Figure 3-8. Execute Action Dialog Box

All the steps of the programming sequence are listed. Optional steps appear 
in bold. Grayed out options are required for programming and cannot be 
changed. 

4. Make your selections and click Execute to start 
programming. The progress of the programming action appears in the 
Log window. 

Note: Do not interrupt the programming sequence, it may damage the device 
or programmer.

The message 'Exit 0' indicates that the device has been successfully programed, 
as shown in Figure 3-9.
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.

Figure 3-9. Successfully Programmed Device

If you encounter any failures, please refer to “Error Messages & Trouble 
Shooting Tips” for more information.

Verifying the Correct Programming

To verify the device is programmed with the correct STAPL file:

1. Load the STAPL file.

2. In the Action list, click VERIFY.

3. Click the Execute button in the toolbar, as shown in Figure 3-
10. 

Figure 3-10. Execute Toolbar Button
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Chapter : Using FlashPro Lite
The Execute Action dialog box appears, as shown in Figure 3-11.

Figure 3-11. Execute Action Dialog Box

The default settings appear in the Execute Action dialog box.

4. Click Execute to start the verification process. A successful 
verification will result in Exit 0, as shown in Figure 3-12. If the STPL file is 
different from the file used for programming, Exit 11 appears in the Log 
window (see “Error Messages & Trouble Shooting Tips”, “Exit 11” for 
more details).
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Permanently Lock the Device
Note: Do not interrupt the verifying sequence, it may damage the device.

Figure 3-12. Successful Verification

Permanently Lock the Device
ProASICPLUS devices have a new feature which enables you to permanently 
lock your device. The permanent lock feature permanently locks your device 
and prevents you from reprogramming. This provides the highest level of 
security to the ProASICPLUS device family. 

Loading the 
Permanent 
Lock STAPL File:

Export the permanent lock STAPL file from Designer. See the note from 
“Loading the STAPL File” in this chapter.

To load the permanent lock STAPL file:

1. Click the Open File button in the toolbar. The Open dialog box 
appears.

2. Select your permanent STAPL file and click Open. The 
Permanent Lock About dialog box displays, as shown in Figure 3-13. 
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Figure 3-13. Permanent Lock About Dialog Box

3. Read the message and click OK to load the permanent STAPL 
file. The FlashPro software loads the file.

Programming a 
Device Using 
Permanent 
Lock

To program a device using Permanent Lock:

1. In the Action list, select PROGRAM.

2. In the Device list, select the device.

3. Click the Execute button in the toolbar, as shown in 
Figure 3-14.

Figure 3-14. Execute Toolbar Button

The Execute Action dialog box appears, as shown in Figure 3-15.
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Permanently Lock the Device
Figure 3-15. Execute Action Dialog Box

Note: The Do_Secure_Permanent checkbox is checked automatically. You 
have the option of unchecking this box. However, if you do, you will 
not permanently lock your device. 

All the steps in the programming sequence are listed. Optional steps appear 
in bold. Grayed out options are required for programming and cannot be 
changed. 

4. Make your selections and click Execute to start 
programming. The progress of the programming action is displayed in 
the Log window. The message 'Exit 0' indicates that the device has 
successfully been programmed as shown in Figure 3-16.
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Figure 3-16. Query Results for the Permanently Locked Device

Note: Do not interrupt the programming sequence, it may damage the 
device or programmer.

If you encounter any failures, please refer to “Error Messages & Trouble 
Shooting Tips” for more information.

Saving Your Log File
All FlashPro results are displayed in the Log window. You can save these 
results into a file.
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Saving Your Log File
To save your log file:

1. From the File menu, click Save Log. The Save dialog box appears, 
as shown in Figure 3-17.

Figure 3-17. Save Dialog Box

2. Select a directory, type in the file name, and click Save. The 
FlashPro software saves the file.
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A
Error Messages & Trouble Shooting Tips

The information in this chapter may help you solve or identify a problem with 
the FlashPro programmer. If you have a problem that you can not solve, please 
contact Actel Customer Technical Support at tech@actel.com or call our 
hotline 1-800-262-1060. We are dedicated to making FlashPro as trouble-free 
as possible. This chapter contains information on the following error messages:

• “Exit 0” on page 58

• “Exit 3” on page 58

• “Exit 5” on page 58

• “Exit 6” on page 58

• “Exit 7” on page 59

• “Exit 8” on page 60

• “Exit 11” on page 60

• “Exit 12” on page 60

• “Exit 15” on page 61

• “Exit 17” on page 61

• “Exit 80” on page 61 

• “Exit 90” on page 62

• “Exit 91” on page 62

• Exit Null

• “Cable to target is not connected properly” on page 63

• “Chain Integrity Test Failed: XX” on page 63

• “Could not connect to programmer on port lpt1 or Parallel port device does 
not support IEEE-1284 negotiation protocol” on page 64

• “External Voltage Detected on <Supply>” on page 65

• “Failed self-test. VDDP setting: Expected 2300...27000. Actual 750” on page 
65

• “Loopback Failure TDI -> TDO. Expected 1, Actual 0” on page 66 
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Appendix : Error Messages & Trouble Shooting Tips
• “More than one unidentified device cannot continue” on page 66

• “Self-test” on page 66

• “VDDP Disconnected” on page 67

Exit 0
This message means success. This does not indicate an error.

Exit 3
This occurs when using ProASICPLUS devices.

Possible Cause: Connect was set up for a ProASIC device and the device is 
actually a ProASICPLUS.

Solution: Set up for a ProASICPLUS device.

Exit 5
Indicates a problem in programming setup, also known as “Entering ISP 
Failure.” 

Possible Cause: The A500K device senses the VDDL power supply as being 
on.

Solutions: 

• Power the VDDL down during programming.

• Check that the device has the correct voltages on VDDP, VDDL, VPP, and 
VPN.

Exit 6
JEDEC standard message. The IDCODE of the target device does not match 
the expected value in the STAPL file.
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Exit 7
Possible Causes: 

• User loaded an APA150 STAPL file to program an APA300.

• User selected wrong device.

• Device TRST pin is grounded.

• Noise or reflections on one or more of the JTAG pins caused by the IR Bits 
reading it back incorrectly.

Solutions: 

• Choose the correct STAPL file and select the correct device.

• Measure JTAG pins and noise or reflection. TRST should be floating or tied 
high.

• Cut down the extra length of ground connection.

Exit 7
Unknown algorithm: alg=x, prev=x 
Invaild data read from device

Possible Causes: 

• In the factory row, the factory writes the algorithm revision the part is 
calibrated with. This error occurs with current STAPL files when the revision 
written into the factory row is not rev 2 for ProASIC devices. The STAPL 
files from last year may "exit 7" with newer devices or the older revision may 
cause this failure if the STAPL file used is from latest version. This can occur 
if you are using Engineering Sample parts that are no longer supported, such 
as ProASIC Engineering Sample parts.

• Programming -F ProASICPlus device with old STAPL file.

• Connect VPP and VPN the wrong way around.

• No bypass Caps on VPP VPN, which damaged the device.

Solutions: 

• Re-generate STAPL file from Libero v2.3 SP3 or Designer R1-2003SP3.

• Replace A500K ES parts with commerical parts.
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• Double check VPP and VPN connections.

• Make sure VPP and VPN have correct bypass caps.

Exit 8
This message occurs when the FPGA failed during the Erase operation.

Possible Causes: The device is secured, and the corresponding STAPL file is 
not loaded. The device has been permanently secured and cannot be unlocked.

Solution: Load the correct STAPL file.

Exit 11
The message occurs when the FPGA failed verify.

Possible Causes

• The device is secured, and the corresponding STAPL file is not loaded.

• You used the Libero software v. 2.3 or earlier or the Designer R1-2003 
software or earlier to generate the STAPL file.

• VPN caps were soldered in the wrong polarity.

Solutions: 

• Please load the correct STAPL file.

• Please use later software versions-- at least Libero v2.3 SP1 and Designer R1-
2003 SP1.

• Double check the VPN bypass caps poloarity.

Exit 12
Occurs when security is enabled.

Possible Causes:

• The device is secured and the wrong key/STAPL file was entered.
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Exit 15
• The device is damaged.

• The verification was interrupted and therefore fails, causing it to think the 
device is secure.

Exit 15
This message is a factory Calibration Data CRC Error. During program, erase, 
or verify, the programmer must read back Calibration Data from the FPGA. 
The Data contains a CRC and the programmer uses the CRC to ensure the data 
is not corrupted/wrong.

Possible Causes:

• The device is damaged.

• Noise on the JTAG signals causes the programmer to read back wrong data.

Exit 17
This message means that the device has been secured, write-security enabled.

Possible Causes: 

• The device is secured and the wrong key/STAPL file was entered.

• The device is damaged.

Solution: Please load the correct STAPL file.

Exit 80
Error code results from STAPL files for A500K devices.

Possible Cause: 

• An internal calibration (based on VDDP and VPP) failed.

Solutions:

• Check voltages on the device pins.
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• Check voltages on the VDDP and VPP pins.

Exit 90
This message means that an unexpected RCK is detected. The ProASIC 
devices use either TCK or RCK to shape the programming pulse. The FlashPro 
uses TCK, it does not sense RCK directly. Rather, the device senses RCK and 
FlashPro reads it from the device.

Possible Causes: 

• Noise on the RCK signal.

• You connected a CLK source to the RCK signal.

• The polarized bypass capacitors on VPP or VPN are reversed biased and are 
affecting the programmer’s VPP or VPN output voltage. This is causing 
programming to fail.

• Several FlashPros are programming at the same time and are too close to each 
other.

Solutions:

• Disconnect the RCK and make sure TCK has a clean signal.

• Separate FlashPros away from each other while they are programming 
Internal ISP.

Exit 91
This message occurred because of a calibration data parity error. Before the 
FPGA is programmed, calibration data (stored in the device) are read back for 
programming purposes. The programmer performs a parity check on the data 
to ensure the proper data is read back.

Possible Cause: The device is damaged.

Solution: Please replace the device.
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Exit Null
Exit Null
Possible Causes: 

• Several FlashPros are programming at the same time and are too close to each 
other.

• FlashPro connects to PC parallel port through a dongle key.

• Data length mismatch when performing DRSCAN on STAPL file.

Possible Solutions:

• Separate FlashPros away from each other while they are programming.

• Connect FlashPro to PC parallel port directly.

• Regenerate STAPL file in case you mistakenly modified the file.

Cable to target is not connected properly
When the Analyze command is executed, the FlashPro will look for target 
devices. If the cable connection is wrong, FlashPro senses assumes that nothing 
is connected at all.

Possible Cause: The cable connector is not connected to the header properly 
or the connection from header to the device is missing something. Header pin 
10 is the GND sensing pin. It senses if FlashPro is connected to the target’s 
GND. Also, all other GND pins should be connected to the GND plane.

Solution: Please confirm the connection between header to the device. If the 
board supplies the power to the device, please make sure the voltage level is 
correct.

Chain Integrity Test Failed: XX
When the analyze chain operation is performed, the FlashPro programmer 
expects the first two bits of the data from the device chain to be a “01.” When 
the programmer does not see the 01 pattern, it will return an error and report 
the bit values that it read. For example, if the bits it read were 11, then it would 
return "Chain Integrity Test Failed: 3"
63



Appendix : Error Messages & Trouble Shooting Tips
Possible Causes: 

• The connection between the FlashPro programmer and the Device is 
broken. 

• The programmer cable might not be securely inserted into the header.

• The header is not connected to the JTAG pins of the FPGA correctly.

• The configuration setting (ProASIC/ProASICPLUS) does not match the 
target device.

• Noise or reflections on the JTAG pins has caused communication between 
the programmer and the device to fail.

• A dongle is plugged in between the PC parallel port and the FlashPro parallel 
port cable.

Solutions:

• Please secure the connections.

• Check the JTAG pins for signal activity.

• Check for broken TDO, TMS, and TCK pins. 

• After checking all type of connections if the failure exists, you may need to 
replace the first device (the devices closest to the TDO of the programming 
header) in the chain.

• Remove the dongle.

Could not connect to programmer on port lpt1 or 
Parallel port device does not support IEEE-1284 
negotiation protocol

Possible Causes: These errors can occur because the remote device does not 
respond to the negotiation protocol, for a variety of reasons. 

Solutions:

• Make sure the port is connected

• Make sure the connected device is a FlashPro/Lite programmer
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External Voltage Detected on <Supply>
• Turn the programmer on

• Check parallel port setting in BIOS 

• Make sure that there are no dongles in between the parallel port and the 
FlashPro connection

• Try another parallel cable, the parallel cable might be defective

• Check to see if the programmer is damaged (see step 4 in “Software Freeze” 
on page 69)

• Make sure the FlashPro Lite has power. The FlashPro Lite is powered from 
the target board through the Vdd pin of the programming header. Please 
make sure the Vdd pin is connected and the target board is powered up.

External Voltage Detected on <Supply>
From the CONNECT menu, the FlashPro programmer has been told to power 
a supply (one of Vdd, Vddp, Vpp, Vpn) of the FPGA, but it is already driven 
from another source.  The FlashPro has sense-amps on all the power supplies 
to make sure that it does not drive a power supply that is already driven by the 
board.

Possible Cause: The voltage supply for the FPGA is driven by the another 
source (board, external power-supply), but the user forgot to turn off the 
supply in the CONNECT menu.

Solution: Set appropriate options in the CONNECT menu.

Failed self-test. VDDP setting: Expected 2300...27000. 
Actual 750

This failure happens due to low VDDP. A loose cable connector usually causes a 
low voltage or no voltage. 

Possible Cause: The cable may have become loose if the cable was 
disconnected from the target by pulling up on the cable instead of lifting the 
connector directly. 
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Solution: Secure the connection between the cable connector and the 
programming header.

Loopback Failure TDI -> TDO. Expected 1, Actual 0
Possible Causes: An error message indicating a mismatch between expected 
signal values of 1 or 0 indicates a hard failure. The signals will be TCK, OUT0, 
or TDI. 

Solution: Send the programmer back for repair.

More than one unidentified device cannot continue
In order to perform an operation to the ProASIC device, the rest of the devices 
in the chain must be in bypass mode. To put the devices into bypass mode, the 
programmer must need to know the IDCODE (hence the instruction register 
length) of these devices. If there is more than one device in the chain which 
does not support IDCODE command, then the programmer cannot put them 
into bypass mode, therefore cannot reach the desired ProASIC device.

Possible Causes:

• The user has chained the ProASIC device with non-Actel devices. Currently 
that is not supported in our software.

• One or more of the devices in the chain is damaged, and the IDCODE 
cannot be read back.

Solution:

Please remove all non-Actel devices from the chain. If you still experience the 
failure, it is likely that the device's ID CODE can not be read and you need to 
replace the device.

Self-test
Before you program any devices, you should run the self-diagnostic test (see 
“Self-Test” on page 20). The diagnostic software can be found on the Actel 
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VDDP Disconnected
web site. If the test fails, please contact Actel Customer Technical Support at 
tech@actel.com for credit and replacement.

Note: The Self-test is only available for FlashPro, not FlashPro Lite.

VDDP Disconnected
This message occurred because there is no Vddp voltage supply to the FPGA.

Possible Causes: 

• You accidentally turned off the Vddp supply in the CONNECT menu.

• The Vddp supply on the board is not functioning.

Solution: Please check the Vddp supply on the board for appropriate voltages 
and correct the CONEECT menu.
67



Appendix : Error Messages & Trouble Shooting Tips
68



B
Software Freeze

During programming, the device may be damaged due to a voltage/current 
spike. When the device is damaged (usually in the form of a power-supply 
shorted to ground), it causes the FlashPro programmer to lose communication 
with the PC. This in turn causes the software to hang.

To restart the software after a crash:

1. Power-down everything.

• If Vpp and Vpn are provided on the board, power them down first, then 
power down Vdd and Vddp.  Finally, power down the FlashPro and 
disconnect it from the board.

• If the FlashPro is providing all the voltages, power down the FlashPro and 
disconnect it from the board.

2. Close the FlashPro software.

3. On the FPGA, measure resistance between all power supplies 
to GND. If any power supply is shorted to GND, then the 
device is damaged. Don't power up the board.

4. Power up the FlashPro, invoke the FlashPro software, and 
run self-test (“Self-Test” on page 20).

5. Assuming that the FPGA does not have any supply to GND 
short, reconnect the FlashPro and run an Analyze Chain 
(“Analyze Chain and Device Selection” on page 27).
69



Appendix B: Software Freeze
70



C
Product Support

Actel backs its products with various support services including Customer 
Service, a Customer Applications Center, a web site, an FTP site, electronic 
mail, and worldwide sales offices. This appendix contains information about 
contacting Actel and using these support services. 

Actel U.S. Toll-Free Line
Use the Actel toll-free line to contact Actel for sales information, technical 
support, requests for literature about Actel and Actel products, Customer 
Service, investor information, and using the Action Facts service.

The Actel toll-free line is (888) 99-ACTEL.

Customer Service
Contact Customer Service for nontechnical product support, such as product 
pricing, product upgrades, update information, order status, and authorization.

From Northeast and North Central U.S.A., call (408) 522-4480. 
From Southeast and Southwest U.S.A., call (408) 522-4480. 
From South Central U.S.A., call (408) 522-4434. 
From Northwest U.S.A., call (408) 522-4434. 
From Canada, call (408) 522-4480. 
From Europe, call (408) 522-4252 or +44 (0) 1256 305600. 
From Japan, call (408) 522-4743. 
From the rest of the world, call (408) 522-4743. 
Fax, from anywhere in the world (408) 522-8044.
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Customer Applications Center
Actel staffs its Customer Applications Center with highly skilled engineers who 
can help answer your hardware, software, and design questions. The 
Applications Center spends a great deal of time creating application notes and 
answers to FAQs. So, before you contact us, please visit our online resources. It 
is very likely we have already answered your question(s).

Guru Automated Technical Support
Guru is a web-based automated technical support system accessible through the 
Actel home page (http://www.actel.com/custsup/search.html). Guru 
provides answers to technical questions about Actel products. Many answers 
include diagrams, illustrations, and links to other resources on the Actel web 
site. Guru is available 24 hours a day, seven days a week.

Web Site
Actel has a World Wide Web home page where you can browse a variety of 
technical and nontechnical information. Use a Net browser (Netscape 
recommended) to access Actel’s home page.

The URL is http://www.actel.com. You are welcome to share the 
resources provided on the Internet. 

Be sure to visit the Technical Documentation area on our web site, which 
contains information regarding products, technical services, current manuals, 
and release notes.

FTP Site
Actel has an anonymous FTP site located at ftp://ftp.actel.com. Here you 
can obtain library updates, software patches, design files, and data sheets.
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Contacting the Customer Applications Center
Contacting the Customer Applications Center
Highly skilled engineers staff the Customer Applications Center from 7:30 A.M. 
to 5:00 P.M., Pacific Time, Monday through Friday. Several ways of contacting 
the Center follow:

Electronic Mail You can communicate your technical questions to our e-mail address and 
receive answers back by e-mail, fax, or phone. Also, if you have design 
problems, you can e-mail your design files to receive assistance. We constantly 
monitor the e-mail account throughout the day. When sending your request to 
us, please be sure to include your full name, company name, and your contact 
information for efficient processing of your request.

The technical support e-mail address is tech@actel.com.

Telephone Our Technical Message Center answers all calls. The center retrieves 
information, such as your name, company name, phone number and your 
question, and then issues a case number. The Center then forwards the 
information to a queue where the first available application engineer receives 
the data and returns your call. The phone hours are from 7:30 A.M. to 5:00 A.M., 
Pacific Time, Monday through Friday.

The Customer Applications Center number is (800) 262-1060.

European customers can call +44 (0) 1256 305600.
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Worldwide Sales Offices

Headquarters
Actel Corporation 
955 East Arques Avenue 
Sunnyvale, California 94086 
Toll Free: 888.99.ACTEL
Tel: 408.739.1010 
Fax: 408.739.1540

US Sales  
Offices

California

Bay Area
Tel: 408.328.2200
Fax: 408.328.2358

Irvine
Tel: 949.727.0470
Fax: 949.727.0476

San Diego
Tel: 619.938.9860
Fax: 619.938.9887

Thousand Oaks
Tel: 805.375.5769
Fax: 805.375.5749

Colorado

Tel: 303.420.4335
Fax: 303.420.4336

Florida

Tel: 407.677.6661
Fax: 407.677.1030

Georgia

Tel: 770.831.9090 
Fax: 770.831.0055

Illinois

Tel: 847.259.1501
Fax: 847.259.1572

Maryland

Tel: 410.381.3289
Fax: 410.290.3291

Massachusetts

Tel: 978.244.3800
Fax: 978.244.3820

Minnesota

Tel: 612.854.8162
Fax: 612.854.8120

North Carolina

Tel: 919.376.5419
Fax: 919.376.5421

Pennsylvania

Tel: 215.830.1458
Fax: 215.706.0680

Texas

Tel: 972.235.8944
Fax: 972.235.965

International Sales 
Offices

Canada 
Suite 203 
135 Michael Cowpland Dr, 
Kanata, Ontario K2M 2E9
Tel: 613.591.2074 
Fax: 613.591.0348

France 
361 Avenue General de Gaulle 
92147 Clamart Cedex
Tel: +33 (0)1.40.83.11.00 
Fax: +33 (0)1.40.94.11.04

Germany 
Actel GmbH
Lohweg 27, 
D-85375 Neufahrn, Germany
Phone: +49.(0)81.659.584.0
Fax: +49.(0)81.659.584.10
Hong Kong 
39th Floor,  
One Pacific Place,  
88 Queensway 
Admiralty,  Hong Kong 
Tel: +011.852.2273.5712 
Fax: +011.852.2918.9693

Italy 
Via Giovanni da Udine No. 34 
20156 Milano
Tel: +39 (0)2.3809.3259 
Fax: +39 (0)2.3809.3260

Japan 
EXOS Ebisu Building 4F 
1-24-14 Ebisu Shibuya-ku 
Tokyo 150
Tel: +81 (0)3.3445.7671 
Fax: +81 (0)3.3445.7668

Korea 
135-090, 18th Floor,  
Kyoung Am Building 
157-27 Samsung-dong 
Kangnam-ku, Seoul
Tel: +82 (0)2.555.7425 
Fax: +82 (0)2.555.5779

Taiwan 
4F-3, No. 75, Sec. 1, 
Hsin-Tai-Wu Road, 
Hsi-chih, Taipei, 221 
Tel: +886 (0)2.698.2525 
Fax: +886 (0)2.698.2548

United Kingdom 
Dunlop House, 
Riverside Way 
Camberley, 
Surrey GU15 3YL
Tel: +44 (0)1276.401452 
Fax: +44 (0)1276.401490
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For more information about Actel’s products, call 888-99-ACTEL  
or visit our Web site at http://www.actel.com

Actel Corporation • 955 East Arques Avenue • Sunnyvale, CA USA 94086 
U.S. Toll Free Line: 888-99-ACTEL • Customer Service: 408-739-1010 • Customer Service FAX: 408-522-8044 
Customer Applications Center: 800-262-1060 • Customer Applications FAX: 408-739-1540

Actel Europe Ltd. • Dunlop House, Riverside Way • Camberley, Surrey GU15 3YL • Tel: +44 (0)1276.401452 •  
Fax: +44 (0)1276.401490

Actel Japan • EXOS Ebisu Bldg. 4F • 1-24-14 Ebisu Shibuya-ku • Toyko 150 • Japan 
Tel: +81 (0)334-457-671 Fax: +81 (0)334-457-668 5029138-6
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